CETECERP

Day 2: Session #3 - Data/Reporting



POLL

Raise your hand if you pronounce it:

- Day-tah ?
- Dad-uh?



RESULTS

Data Pronunciation in the USA, in the UK, and in Europe

Some people say “day-tuh” and others say “da-tuh.” Both are acceptable. ... Because of the
mix, either pronunciation is acceptable. As an American living in Europe and speaking

French, | can assure you the both pronunciations are acceptable.

https://analystanswers.com > data-vs-data-data-are-data-is-...

Data vs data: “data are/data is” & “day-tuh/da-tuh” - Analyst ...




RESULTS
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RESULTS

- DAY-TUR!I!




WHY?

e Data points alert you
® You can make inferences from that data

e ..Which helps you make decisions about
things.



WHY?

E.o. Decisions About Health

e Data point: | weigh more now than at age 22

e Inference: | have drank too much beer in the
past 10 years

e Decision: NEXT SLIDE!



THE PROBLEM: Three Parts

1. Creating a process to ensure good data
collection. (this is what ERP forces)



THE PROBLEM: Three Parts

I—Creatthg-aprocesstoensuregooddata
Heotion—(this—iow : ;

2. Reporting on that data so it’s easy to “see”.



THE PROBLEM: Three Parts

I—Ereatingaprocessteensuregood-date
Heetion—(thisiswi : ;
2. RE|35I=*‘EOIHg Eﬁ :Elaat Ela:Ea SE ’I:E’S EES”:EE “_S EE”.
3. Drawing inferences from the data and
making better decisions for your business!



Today’s Problem: Reporting on Data

2. Reporting on that data so it’s easy to “see”




Four Ways To Report On Data

1. Canned reports/dashboards in Cetec ERP
2. Cetec ERP Bl Customization
3. Export + Excel Skills

4. Excel Web Feeds From Cetec API
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1. Canned Reports & Dashboards

Cetec ERP is the authoritative data hub, the
primary source of data in your business.

The ERP system itself contains numerous
screens/reports to help you “see” that data.



1. Canned Reports & Dashboards

CETECERP

¥

v INVOICES v

> |INVOICE LIST

Invoice Lis

Invoice

Invoice #

Date Type Invoice Date

Cust Part

Deferred Revenue

More Options

Intercompany All

Location

—>Ea 3




1. Canned Reports & Dashboards
éViewBy Header More Options m m

Note: Some columns are excluded on exports of > 1000 rows. Consolidated invoices can be accessed by clicking on a Customer, then selecting "Consolidated Invoices" from the side bar.

Displaying 1 - 11 of Export  +/- Columns

Invoice Customer Cust PO Invoice Date # Lines Ext Resale Total Unpaid GM GP Adjust GM Print?

1016.1-1 Vance Refrigeration 20398423432423 2021-10-06 $1,000.00 $1,000.00 $1,000.00 0.00 % $0.00 0.00 %
28-0 Schrute Farms 2021-10-06 $300.00 $300.00 $0.00 100.00 % $300.00 100.00 %
1014.1-1 Guitar John 2021-10-05 $809.15 $864.15 $864.15 -9900.00 % $-80,105.85 -9900.00 %
1006.1-1 Vance Refrigeration 01927470 2021-10-01 $0.00 $0.00 $0.00 $-2,276.88

15.1-2 Vance Refrigeration 01927470 2021-09-21 $10,738.00 $10,748.00 $10,748.00 71.18% $7,643.00 71.18%

36.1-1 Schrute Farms P0O1234 2021-09-29 $6,500.00 $6,500.00 $0.00 100.00 % $6,500.00 100.00 %
Edge Products 2021-09-29 A $100.00 $100.00 90.00 % $90.00 100.00 %
Vance Refrigeration 124152 2021-09-29 $711.75 $711.75 -116.89 % 4 -116.89 %

Creenshons
' p — 3 ; <0.0f .0 , 5,250, o
N ew OMONR OSSR e d=1 22 port_rows=2corn parny=ait P cusipo=ait date=20212094P2%10 2l ';?'?‘:*-' einvoicesMDnier COMMpEr /&'35/"{ pari=geusirart=2orde 1/;:*5?*:5 Pansizr=ae

D000 0|]0O|0|0O
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1. Canned Reports & Dashboards

INVOICE VALUES

MN, MZ, SD, MC, FO

Ext Resale @ GP Value

Yesterday $0.00 $0.00 $0.00 0%
Today $0.00 $0.00 $0.00 0%
MTD $2,109.15 $84,191.88 $-82,082.73 -3891%
Prior MTD $0.00 $0.00 $0.00 0%
Prior Year MTD $0.00 $0.00 $0.00 0%
Prior Month $18,255.04 $4,709.70 $13,545.34 74%
YTD $20,364.19 $88,901.57 $-68,537.39 -336 %
Prior YTD $0.00 $0.00 $0.00 0%

Prior Year $0.00 $0.00 $0.00 0%




1. Canned Reports & Dashboards

® There are a bunch of these in Cetec ERP
e We continue to add more and more of them

What if | want to make my own?



Four Ways To Report On Data

+—Ganned-reportsidashbeardsin-Getee ERP
2. Cetec ERP BI Customization

3. Export + Excel Skills

4. Excel Web Feeds From Cetec API
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2. Cetec ERP Bl Customizations
+ B & %

OUR DATA

A/P Payments

Addresses Bin Inventory

Booking Lines Closed P/O Lines Customers

Inside Sales Reps Inventory Invoice Lines

Invoice Lines As Used Open Order Lines

Outside Sales Reps




2. Cetec ERP Bl Customizations

New question

Invoice Lines ~

(

DOING SCIENCE...




2. Cetec ERP Bl Customizations
+ 0 & %

New question

DATA FILTERED BY GROUPED BY

Invoice Lines ~

VISUALIZATION

W Table - %6 [ Getpnswer ]
Invoice Number Customer Customer Part Number Ext Actual Labor Ext Cost Ext Estimated Labor Ext Labor Variance Ext Margin Ext Resale
MN1.1-1 Exxon 100 70.6 0 2431 S 155.54
MN3.1-1 Apple 100 60.6 -2.08 9394 20,000
MN7.1-1 Apple v 1,000
MN7.1-1 Apple
MN7.1-1 Apple

Exxon

Exxon

U SCreensnots

.. Exxon , .
oroductfigaiure-dermosireporing/custom-raporiing-oi-overyigw.himl




2. Cetec ERP Bl Customizations
+ B &

Invoice Lines ~

ALIZATION a € Sumof..

B Table v ¥
~— Invoice Line
Invoice Number Customer Customer Part Numbe :stimated Labor Ext Labor Variance Ext Margin

MN1.1-1 Exxon ext 2431 84.94

MN3.1- Apple -2. 9.9394
3.1-1 D Ext al 2 208 19,939

MN7.1-1 Apple 0 996
Ext Cost

MN7.1-1 Apple 0 1.9
Ext Estimated Labor

MN7.1-1 Apple 0
Ext Labor Variance

MNS5.1-1 Exxon
Ext Margin

Exxon




2. Cetec ERP Bl Customizations
sz [N + B o4 B

New question

Invoice Lines ~ Q )

B Number v 3#

—>714,827.92




2. Cetec ERP Bl Customizations
+ B & B

New question

Invoice Lines ~

e B Invoice Line

B Number v ﬁ
Customer

Bill To Name

714,82

IS

zature-dermos/reporting/custorm-reporting-ni-overyiew.ntrml




2. Cetec ERP Bl Customizations
+ B oA B

New question

DATA FILTERED BY GROUPED BY
Invoice Lines ~ m «t R on * N e

VISUALIZATION Invoice Line

& Number v $¥
ship

Ship Date

Ship Qty

Ship To

714,827.92 "

« ISR

Quarter
Year
Send = & Minute of hour

zcarp.com/product/f e-demosireporting/custorn-r2porting-oi-over

Hour of da




2. Cetec ERP Bl Customizations
+ B & %

New question save G B W =

DATA FILTERED BY VIEW GROUPED BY

Invoice Lines ~ m

B s Comaiitt Ship [ of Ext R om N and
VISUALIZATION
s Y

DOING SCIENCE...




2. Cetec ERP Bl Customizations
+ B &

New question

Ship Date: Month Resale

24 Hour Fitness  May, 2018 $1,050.00
e

24 Hour Fitness  Sep, 2018 $2,000.00
24 Hour Fitness  Oct, 2018 $46.00
24 Hour Fitness  Nov, 2018 -$5.00
ABC Shirts Mar, 2018 $40,100.00
ABC Shirts May, 2019 $70.50
ABC Shirts Jun, 2019 -$1,003.00

Send Screensnots

1 , £
protMe A8 r=-darme ,,v‘.":yu,"?'rm':. storn-reporting-bi-overvizy.nimnl




2. Cetec ERP Bl Customizations

Columns  Conditional Formatting

Pivot the table I I

E Name Ship Date: Month
24 Hour Fitness May, 2018

Visible columns 24 Hour Fitness Sep, 2018

Click and drag to change their order 24 Hour Fitness Oct, 2018
Name 24 Hour Fitness Nov, 2018
ABC Shirts Mar, 2018
Ship Date ABC Shirts May, 2019 705
ABC Shirts Jun, 2019 -1,003
Sum
Apple Jan, 2018 500
k
Apple Feb, 2018 315,593

Apple Mar, 2018 246251

Rows 1-10 of 54

Explain and SEIlle 1501 C' Reset to defaults Cancel m
WUWIEETEN ). o/ product/featur zushitrnl

ure-dermosireporting/custorm-reporting-oi-overyiew.nim




2. Cetec ERP Bl Customizations
+ 0 & B

New question
DATA FILTERED BY GROUPED BY

Invoice Lines ~ m

VISUALIZATION

Name January, 2018 February, 2018 March, 2018 April, 2018 May, 2018 June, 2018 July, 2018 August, 2018 September, 2018 October, :

24 Hour Fitness $1,050.00 $2,000.00 $4
ABC Shirts $40,100.00

Apple $315,593.00 $2,462.51

Boeing $7,441.60

Boston Scientific (Q;p.

Ceco Building

Design & Fab Contractors

$2,500.00 $500.00

miprod ure-demosiregorting/custorn-reporting-oi-overyizy.niml




2. Cetec ERP BI Customizations
+ 0 & B

New question

DATA FILTERED BY GROUPED BY

Invoice Lines ~ m

y

VISUALIZATION

. Table v ¢ C' Refresh B showing 54 rows ‘

y, 2018 February, 2018 March, 2018 April, 2018 May, 2018 June, 2018 July, 2018 August, 2018 September, 2018 October, :

1,050 2,000

Tabl:
W Table 315,593
~ Ling

& Area

Jl Bar

ature-demos/reporting/custorn-regorting-ni-ovarvizw.ntml




2. Cetec ERP Bl Customizations
+ 0 A& B

New question

Invoice Lines m

peranme”
24Ho ABC @ A B: @ BostonSc Ceco ® Design&F. @ Disn« ® EIC E ®F ® Hom @ Kee ® NewCus ® Re TestC @ Texas Univers @ Who
300,000
250,000
200,000
150,000

100,000

2ot/ CUSIO=-r2gorang-or-o0var /2.1l i o =
Apr, Ju 18 Oct, 2018 Jan, 2019 Apr, 2019




2. Cetec ERP Bl Customizations
i Q Search.. + B & B




2. Cetec ERP Bl Customizations

What if | don’t have Cetec ERP BI?

e How much is getting your own quick custom
reports worth? Could you quantify it?

e Any time recovered from chasing reporting?

e Excel skills are valuable! (up next)



Four Ways To Report On Data

+—Ganned-reportsidashbeardsin-Getee ERP

3. Export + Excel Skills

4. Excel Web Feeds From Cetec API
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3. Export + Excel Skills

Case Study: Inventory Aging

e | want to see my current inventory $
e Aged into monthly buckets



3. Export + Excel Skills

Part List By Bin

Prcpart

Expires (from)

Lot Code

Drawing Number

Prcpart

o Information: Wait on this page for the document to download when done.

will also be available in My Exports when finished

The export x

Created (from)

Is Locked

<<Previous |12 3 4 5 6 7 8 |#f/Next>> ViewAll

Displaying 1-50 of 369  Expo +/- Columns

Receipt Bin Qty uoMm Bin Cost Bin Ext Value

Location
ABC Code

BOMs All

Include Total Value? O m

Pick Qty Shelf Qty Created On

SUB200

RAW2847199

847 $305.30 $305.30

840 $0.44

2021-10-08




3. Export + Excel Skills

1852-part_list_by location (1) % B &

File Edit View Insert Format Data Tools Add-ons Help Lasteditwas seconds ago

00% v $ % .0 .00 123+  Default(Ca.. v 11 - B I S A & H
- - —

PRC
B c D E F G H I J K L

Part Prcpart Receipt PrimaryBBinQty UOM Bin Cost Bin Cost Bin Ext Va Bin Ext VaPick Qty Shelf Qty Created On
200 SUB200 847 SUB200 1 305.30 305.3 305.30 305.3 1 2021-10-08
2847199 RAW2847 840 RAW2847 10 EA 0.44 0.436847 4.37 4.368477 10 2021-10-08
9462711 RAW9462 839 RAW9462 100 EA 1.50 1.5 150.00 150 100 2021-10-08
8392785 RAW8392 838 RAWS8392 10 EA 0.23 0.22539 2.25 2.2539 10 2021-10-08

3 PRT3 837 PRT3 7 EA 3.00 3 21.00 21 7 2021-10-08

2 PRT2 836 PRT2 10 EA 2.00 2 20.00 20 10 2021-10-08

1 PRT1 835 PRT1 10 EA 1.00 1 10.00 10 10 2021-10-08

LAE6SBLA CANLAEGS 834 S0 FT 0.50 0.5 25.00 25 50 2021-09-29
CBO2GRE CANCBO2 832 8 5.00 S 40.00 40 8 2021-09-29
70-0142 CBL70-01 831 4 0.50 0.5 2.00 2 4 2021-09-29
LAE6SBLA CANL4EGS 830 20 0.20 0.2 4.00 4 0 2021-09-29
BCPB25H' CANBCPB 829 20 1.00 1 20.00 20 20 2021-09-29
CBO2WHI CANCB02 828 10 4.50 4.5 45.00 45 10 2021-09-29
CBO2RED CANCBO2 827 10 4.00 4 40.00 40 10 2021-09-29
CBO2GRE CANCBO02 826 10 5.00 5 50.00 S0 2021-09-29
CBO2WHI CANCB02 825 6 4.50 4.5 27.00 27 2021-09-29

M SznlBG2EEBICANCBO2 824 6 4.00 4 24.00 24 2021-09-29
ooyl300EEEr S e/ dILong Ry sz o T AGl-an@ s W AW vdO-qovwRBBYED (/zditgid=1455489563 2021-09-29

O OO0 00000 OoOOo

o




3. Export + Excel Skills

E 1852-part_list_by location (1) ¥ (&)

File Edit View Insert Format Data Tools Add-ons Help Lastedit was seconds ago

A~ P 100% v Theme [New v Automatic

Created On Plain text

B c Number

Part Prcpart | Number 1,000.12 1 Shelf Qty

200 SuUB200 Bold Ctrl+B 1
2847199 RAW2847 . 10
9462711 RAW9462 halle Gt Scientific 1.01E403
8392785 RAW8392 Underline Ctrl+U

3 PRT3 :
2 PRT2 Strikethrou Alt+Shift+5 Accounting $ (1,000.12)

Percent 10.12%

10

7
10
10(2021-10-
50|2021-09-

1 PRT1 Financial (1,000.12)
LAE6SBLA CANLAE6S Font size
CBO2GRE CANCBO02
70-0142 CBL70-01 Alian Currency (rounded) $1,000
LAE6SBLA CANL4EGS g
BCPB25H' CANBCPB Merge cells
CBO2WHI CANCB02
CBO2RED CANCBO2 Text wrapping Time 3:59:00 PM
CB02GRE CANCBO02 Text rotation
CBO2WHI CANCBO2 Date time 9/26/2008 15:59:00
CBO2RED CANCBO02
CBO2GRE CANCB02 Conditional formatting

1
2
3
4
5
6
2,
8
9

Currency $1,000.12

Date 9/26/2008

S S S = = A Y = R = == A= R = A = =R ==

Duration 24:01:00




3. Export + Excel Skills

a 1852-part_list_by location (1) ¥ &)

File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ago

100 v $ % .« Sort sheet by column A, A —~ Z s A S

- Sort sheet by column A, Z - A

Part Prcpart Receipt | Sort range by column A, A - Z Ext Val Bin Ext Va Pick Qty Shelf Qty Created On
200 SUB200 847 ¢ 30530 3053 0 1 10/8/202
2847199 RAW2847 840 | Sort range by column A, Z ~ A 437 43684771 0 10 10/8/202
9462711 RAW9462 839 | 150.00 0 100 10/8/202
8392785 RAWS392 838 | Sort range 2.25 0 10 10/8/202
3 PRT3 837 | . 0 7 10/8/202
2 PRT2 836 | Create a filter 0 10 10/8/202
0 10 10/8/202

0 50 9/29/202

0 8 9/29/202

0

1 PRT1 835 |
LAEGSBLA CANLAE6¢ 834

CBO2GRE CANCB0O2 832 Slicer
70-0142 CBL70-01 831 4 9/29/202
L4EGSBLA CANLAEES 830 R 0 0 9/29/202
BCPB25H CANBCPB 829 ; 20 9/29/202
CBO2WHI CANCB02 828 Pivot table . 10 9/29/202
CBO2RED CANCBO2 827 _ ; 10 9/29/202
CBO2GRE CANCBO02 826 RandomizeTangs 10 9/29/202
CBO2WHI CANCBO2 825 Nanad ranges . 2 9/29/202
CBO2RED CANCB0O2 824 ; 2 9/29/202
CBO2GRE CANCB02 823 Protected sheets and ranges i 2 9/29/202

Filter views




3. Export + Excel Skills

1852-part_list_by location(1) % = &

File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ago

00 v $§ % .0 .00 123v  Default(Ca.. ~ 11 -~ B I & A & H
- - —

Values

.google.c dshzet Szy Mo TrnAGH-2mQ8W A vdO-ovwREE =2059485253

EH Pivot table editor

Sheet1!1:1000

Suggested

A / e
Add

Columns

Values Add

Filters




Paste special

Insert column

Create pivot date group

Get link to this cell

Comment

Insert note

Ctrl+C

Second

Minute

Hour

Hour-Minute (24 hour)
Hour-Minute (12 hour)
Day of the week

Day of the year

Day of the month
Day-Month

Month

Quarter

Year

Year-Month

Year-Quarter

EH Pivot table editor

Sheet1!1:1000

Suggested

Rows

Created On

Order

Ascending

Show totals

Columns

Values

Filters

Sort by
Created On




3. Export + Excel Skills

E 1852-part_list_by location (1) & &)

File Edit View Insert Format Data Tools Add-ons Help Lastedit was seconds ago

~ ~ & P 1005 v $ % .0 00 123v Default(Ca. v 11 ~ B I & i ¢ H =

EE Pivot table editor
000 Created On - Month

e T T

Jan
Feb Suggested

Mar

Aok Rows
May
Jun
Jul
Aug
Sep Ascending Created On - ...
Oct
Nov
Dec

Created On - Month

Order Sort by

Show totals

Columns

Grand Total

Values




File Edit View Insert Format

100% $ % .0
-

Created On - Month

B

Grand Total

Data Tools Add-ons Help Last edit was seconds ago

EH Pivot table editor

Sheet1!1:1000

Suggested

Rows é Add

Created On - Month X

Order Sort by

Ascending CreatedOn-.. ~

Show totals

Columns
Values

Filters

Part
Prcpart

Receipt

Bin Cost

Bin Cost




3. Export + Excel Skills

Created On - Month

) v
I O O T oo Propart
Created On - Mg

Receipt

Suggested Primary Bin

Rows BinQry

UoMm

Created On )
Bin Cost

Order Sort by

Ascending eated On Bin Cost

Show totals Bin Ext Value

Bin Ext Value

Columns Pick Qty

Grand Total
Shelf Qty

Values
Created On

Filters Spliiminio




File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ago

00% v $ % .0 .00 123  Default(Ca. v 11 - B I & A & H

B Pivot table editor

B c Order Sort by
Created On - Month Bin Ext Value _ Ascending Created On-.. ~
Jan 15.00
120.00 Show totals
160.00 I:I Repeat row labels
600.00
719.40

Jan Total Bin Ext Value
= Feb 0.00 Order Sort by
2.50 Ascending Bin Ext Value ~
2.92
22.50 Show totals
40.00
50.00
171.00 Columns
180.00
4488.52
195000.00
234000.00
Feb Total Filters

: Mar

Values

1T AGH-2mQ8W AN ydO-c oy




3. Export + Excel Skills

V 10 R )

File Edit View Insert Format Data Tools Add-ons Help Lastedit was 2 minutes ago

100 ~ $ % .0 .00 123+  Default(Ca.. v 11 - B I 5 A & H
- . —

EE Pivot table editor

= £ Order Sort by
Created On - Month Bin Ext Value _ Ascending CreatedOn-.. ~
E Jan 15.00
120.00
160.00 D Repeat row labels
600.00
719.40

Show totals

Jan Total Bin Ext Value

ﬂ Feb 0.00 Order Sort by
2.50 Ascending Bin Ext Value ~
2.92
22.50 Show totals
40.00
50.00
171.00
180.00
4488.52
195000.00
234000.00
Feb Total
& Mar 0.00
4.25




(C2) A @ v

File Edit View Insert Format Data Tools Add-ons Help Lastedit was 3 minutes ago

100% v $ % .0 .00 123v Defaut(Ca. v 11 ~ B I & i . H B Pivot table editor Calculated Field

PRC

B c

Created On - Month Bin Ext Value _ Ascending Createdon  Fart

Jan 15.00
120.00 Show totals

160.00 D Repeat row labels Receipt

Prcpart

600.00

719.40 .
Iandotal Il Bin Ext Value Bin Qty

= Feb 0.00 Order Sort by
2.50 Ascending Bin Ext Valt
292
22.50 Show totals
40.00 Bin Cost

50.00 )
171.00 Columns Bin Ext Value

180.00 /’ Bin Ext Value
4488.52 Values

195000.00 Pick Qty
234000.00
. Shelf Qt
Feb Total Filters oy
B Mar 0.00 Created On
4.25

Primary Bin

uoM

Bin Cost




File Edit View Insert Format Data Tools Add-ons Help Lastedit was seconds ago

100% ~ % .0 .00 123+  Default(Ca.. v 11 - B I S A & H
- - —

1614.4

A B c

Created On - Month Bin Ext Value SUM of Bin Ext Value

Jan 15.00
120.00
160.00
600.00
719.40

Jan Total
& reb 0.00
2.50
2.92
22.50
40.00
50.00
171.00
180.00
4488.52 4488.5192
195000.00 390000
234000.00 234000
Feb Total 629007.4368
0.00 0
4.25 4.2548

oY RSz Moy T A S -2 /Ay dO- oy (lediti#gid=2059465233

BEH Pivot table editor

Show totals

D Repeat row labels

Bin Ext Value

Order

Ascending

Show totals

Columns

Values

Bin Ext Value

Summarize by

SUM

Filters

Sort by

Bin Ext Value

Show as

Default




3. Export + Excel Skills

a 1852-part_list_by location (1) ¥ )

File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ago

~ o~ P 100% .0_ 00 123~  Defaut(Ca. v 11 ~+ B I & A -

15.00
120.00
160.00
600.00
719.40

0.00
2.50
2.92 Columns
22.50
40.00
50.00 Values
171.00
180.00 180 Bin Ext
4488.52 4488.5192
195000.00 390000
234000.00 234000
629007.4368
0.00 0
4.25 4.2548

Summarize

SumMm

Filters




3. Export + Excel Skills

A B c

Created On - Month Bin Ext Value SUM of Bin Ext Value

[- $15.00 $15.00
$120.00 $120.00
$160.00 $160.00
$600.00 $600.00
$719.40 $719.40

Jan Total $1,614.40

& reb $0.00 $0.00

$2.50 $2.50

$2.92 $2.92
$22.50 $22.50
$40.00 $40.00
$50.00 $100.00
$171.00 $171.00
$180.00 $180.00
$4,488.52 $4,488.52
$195,000.00 $390,000.00
$234,000.00 $234,000.00

Feb Total $629,007.44

B mar $0.00 $0.00

$4.25 $4.25

AA A Aa ~a

S |[ojlo|ow|/N|loun|ls|lw|[Nn[=]o

3




3. Export + Excel Skills

1852-part_list_by location (1) 7% &)

File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ago

100% v~ S % .0 .00 123~ Default (Ca.. v 11 v B I S

Created On - Month

Bin Ext Value

$15.00
$120.00
$160.00
$600.00
$719.40

$0.00

$2.50

$2.92
$22.50
$40.00
$50.00
$171.00
$180.00
$4,488.52
$195,000.00
$234,000.00

$0.00

shzstsfdLolV a8 N og T

SUM of Bin Ext Value

$15.00
$120.00
$160.00
$600.00
$719.40
$1,614.40
$0.00

$2.50

$2.92
$22.50
$40.00
$100.00
$171.00
$180.00
$4,488.52
$390,000.00
$234,000.00
$629,007.44
$0.00

T 425

REy Ve




3. Export + Excel Skills

100% v $ % .0 .00 123v  Default(Ca.. v 1 A & H
—

e A .
r 4> (i) Chart editor
Created On - Month
I c > ] . | _F | o Setup Eustoniee
SUM of Bin Ext Value -

Bin.l:'xt Value

] /
Bin Ext Value and SUM of Bin Ext Value ; " i

B BinExtValue [ SUM of Bin Ext Value 4L Column chart

$1,000,000.00

Stacking
$750,000.00

None
$500,000.00

Data range

A1:.C306

X-axis

Jun Total
Grand Total

Tr Created On - Month

Created On - Month D Aggregate

Series

1d0-covwRJE(ED ([adittgid=2




3. Export + Excel Skills

a E @ Share
File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ago

= = % .0 .00 - - v S 1 . .
-~ o~ P 100% $ % .0 .00 123 Default (Ca. 1 B I & i ®. H [@ Charteditor

& 8 & Setup 9Customize
Created On - Month Bin Ext Value SUM of Bin Ext Value

Jan $15.00 $15.00
$120.00 $120.00 Inventory Aging By Month
$160.00 $160.00 | ¢1000,000.00
$600.00 $600.00
$719.40 $719.40

Jan Total $1,614.40
2l o gl [
$2.92 $2.92
$22.50 $22.50 $250.000.00 Title text
$40.00 $40.00 J—l
$50.00 $100.00 $0.00 e — Inventory Aging By Month
$171.00 $171.00
$180.00 $180.00 -$250,000.00
$4,488.52 $4,488.52 « 1\6‘"} & ;\6& ‘]:a‘ «6& « /\6“’} & l\o“} s /\o"’} $ «o"b\ S ;\o‘:} St ¢ Title font Title font size
$195,000.00 $390,000.00 & ¢ & S S S
$234,000.00 $234,000.00 Auto
Feb Total $629,007.44 Created On - Month
B Mar $0.00 $0.00 B
$4.25 $4.25

Aa

Chart style

v Chart & axis titles
$750,000.00

Title format Title text color

Auto ~
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Created On - Month Bin Ext Value
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$160.00
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$2.92
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$0.00

$4.25

Inventory Aging By Month

$1,000,000.00
$750,000.00
$500,000.00
$250,000.00

$0.00

-

-$250,000.00

S AR

&°
¢ & @7’(

& A
W A\O‘@
)

AQ'

<O’

S

>
)
S S

Created On - Month

> > N >
S & b 2
W K

5 b gD
\50«6&02’«0"«6\‘

&




Four Ways To Report On Data

+—Ganned-reportsidashbeardsin-Getee ERP
I—Eepoert+Ereel-Skills

4. Excel Web Feeds From Cetec API

55



4. Excel Web Feeds From Cetec API

& C' @& demo.cetecerp.com/otd/order/list?reloaded=1&debug=&ordernum=&prcpart=&revision=&custnum=&custname=&cu.. & W ﬁ ‘B i~ E B » @ :

@ Textedit € CetecERP € help.cetecerp.com G license-freeimages [ newdrawing € Sales- Customer (€ Customer BECKMA.. [ Secure Shell 0.41 » Reading list

Parts Call Out

Less Options m

<<Previous |12 3 4 5| Next>> ViewAll
Displaying 1-400f 182 Export +/- Columns
Work

Warehouse Prcpart Customer Start
Date

Ship Est: Labor Incomplete

Date Labor Workitoc

Internal 2021-10- 2021- .
BOM99-1000 Aeeauni 20 10-20 ; $764.50 Mill

Internal 2021-10- 2021- Doc Control
SUB19284 . i i} 20.00
Account 20 10-20 3 (Unreleased)

Vance 2021-10- 2021- Doc Control
BOM1000 Refrigeration 20 10-20 . 38,144.95 (Unreleased)

Vance 2021-10- 2021- Doc Control
BOM1000 5 1 i 11,402.93
Refrigeration 15 10-18 3 (Unreleased)

Vance 2021-10- 2021- Doc Control
EORICO Refrigeration 15 10-15 SRR : SEER 51,859.79 (Unreleased)
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CETEC ERe

v  CONFIG SETTINGS v

Config Settings

Name  JSONAPI Description

Category Description

Category All

Updated

By Updated On

Preshared Token to pass for any JSON API calls (as param

Authentication
. eeh preshared_token)

jenB39vj9ivRH80a 2018-12-14
04:46:17 PM

X
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x 4+

C (@ https://demo.cetecerp.com/api/ordline?preshared_token=jenB39vj9ivRH80oa&deleted_flag=0

P Textbdit € CetecERP (€ help.cetecerp.com & license-free images B newdrawing (€ Sales-Customer € Customer BECKMA.. - Secure Shell 0.41
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AutoSave ®v = Book1 - Excel

File Home Insert Draw Page Layout Formulas Data BB Click Data > From Web then

[ba From TeXt/CSV [89 Recent Sources |r>3 @Queries ctions e nte r the A Pl U rI fro m a bove
[5 From Web ['E] Existing Connections ~ =] .
Refresh — and click OK.

Get
Data v % Fr le/Range All v B

et & Transform Data Queries & Connections

From Web

® Basic © Advanced

URL
https://demo.cetecerp.com/api/ordline?preshared_token=jenB39vj

S

Cancel

O 00 NO UV A W N -



4. Excel Web Feeds From Cetec API

List Tools ordline?presh

Home Transform Add Column View Transform

O Click To Table and then OK.

Reverse Items 2
To Keep Remove Statistics
Table tems~ Items~ X

K WX B.f Remove Duplicates 4|
‘ 1] z
A

Convert Manage ltems Sort Numeric List

Jx = Json.Document (Web.Contents (" https//demo.cetecerp

List

—h

Record ®) Tat e

Record

7]
2
]
3
o

Create a table from a list of values
Record
Select or enter delimiter

None

Record

Record

How to handle extra columns
Record
Show as errors
Record

Record

LN YOI IWIN

Record

b
o

Record
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Home Transform Add Column View

— Click the Expand button and
S then OK.

= Properties

~ )

s 1 Advanced Editor x
Close &  Refresh m Choose  Remove Keep Remove
Load~  Preview~ Manage Columns~ Columns~ Rows~ Rows~

Close Query Manage Columns Reduce Rows So

> x able.FromList(Source, Splitter.SplitByN

. 1155 Column 4
O ————— 3

Record

Record
Recond (Select All Columns)

Record

deleted_flag
Record

v
v labor_rate
v
v

resale currencv id
Record

Use original column name
Record

Record List may be ingomplete.

Record

Record Cancel
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ordline?preshared_token=jenB39vj9ivRH80oa&deleted_flag=0 - P

Home Transform Add Column View

Click Close & Load.

|:P= Properties | XY X

i .

s ¢r Advanced Editor x
Close &  Refresh Choose  Remove Keep Remove
load~ Preview~ ' Manage Columns ¥ Columns~ Rows~ Rows~

Close Query Manage Columns Reduce Rows So

> Ja = Table.ExpandRecordColumn(#"Converted to

™. 155 labor_rate v 135 intercompany v | 155 resal

79.98000000
79.98000000

Queries

79.98000000
18.67000000
18.67000000
0.00000000
0.00000000

QIO QIO VIO |Q

0.00000000
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1
2
3
4
5
6
7
8
9

AutoSave (@ of)

File Home

(&
Get

79.98000000 |

79.98000000
79.98000000
18.67000000
18.67000000
0.00000000
0.00000000
0.00000000

10 0.00000000
11 0.00000000

Draw

[B From Text/CSV
[3 From Web
Data v E From Table/Range

Get & Transform Data

I}g. Recent Sources

[\ Existing Connections

79.98000000

0 0.00000000
0 0.00000000
0 0.00000000
0 0.00000000
0 0.00000000
0 0.00000000
0 0.00000000
0 0.00000000
0 0.00000000

Page Layout

Book1 -

Fo |
./

Refresh =
All v

Queries & Connections

Excel

as

Queries & Connections

Properties

Now the query table
connection is completely live.

Click Data > Refresh All at any
time to update the Excel
query table with live Cetec
data.
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PivotTable Reco

1
2
3
4
5
6
7
8
9

AutoSave (@ on)

File

i

Book1 - Excel

Home Insert Draw Page Layout Formulas Data Review View Developer

PivotTables

Tables

5 .7
r(:) '_Ef:mﬁ Add-ins * ’

L) ddine v o

Create PivotChart ?

Choose the data that you want to analyze
@) Select a table or range
Jable/Range:  ordline?preshared_token=jenB39vj%ivRHBoa&de

Use an external data source

Choose where you want the PivotChart to be placed
®) New Worksheet
Existing Worksheet

Location

Choose whether you want to analyze multiple tables

: Add this data 1o the Data Model

ended lHustrations Recommend o tChart

O 0o0oo0oo0oo0Do0oo0oo0ocoo0o o©

Make sure a cell is selected
inside the Query Table
created during the previous
step.

Then click Insert > PivotChart
and then click OK.
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AutoSave (@ of) 9 v

File Home

}v =

Page Layout

Cetec Weblinked Report Examplesx... ~

Insert Draw Formulas Data Review

E=

Insert

View Developer

(& (&

Insert Refresh Change Data Clear
Slicer Timeline v

Help
Chart Name:
Chart 1

Move

Options Chart

Source v »
PivotChart

A B
1 Sum of Ext Resale Column Labels ¥
2 Row Labels R
3 12021
4 #2022
5 Grand Total

Active Field Data Actions

A-10 B-52 Cc-17 C5 E-3 KC-135 Grand Total
784471.2 256807.83 814704.67 282665.66 1628831.11 373738.83 724233.57 4865452.87
150943.41 266984.86 309613.07 1813657.93 284239.8 452338.98 3277778.05
935414.61 523792.69 1124317.74 282665.66 3442489.04 657978.63 1176572.55 8143230.92

Sum of Ext Resale
2000000
1800000
1600000
1400000

1200000

200000 .
y .

20

II -
21

Years 'Y Quarters ~ Sale Date ~

Here the pivot charts can be setup.

Acrobat

Joshua Foraker JF m == X

Power Pivot PivotChart Analyze Design

) = I

Fields, Items, Field Field
& Sets ¥ List |Buttons v

Format

Calculations Show/Hide

PivotChart Fields
Choose fields to add to report:

Mo
[ Date Du
[] sale Date

Drag fields by

Y Filters Il Legend (Series)

Aircraft Platform

= Axis (Categories) Values

Years

Sale Date

(Google has guides on setting up Excel Pivot Tables.)
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File Home Insert Draw Page Layout Formulas Data Review View Developer Help Acrobat Power Pivot
s

What-If Forecast = Qutline
Analysis v Sheet 3

[2‘) From Web [_\ Existing Connections
Get Refresh Geography 'z Filter Text to

Data v B From Table/Range All v ’ S@Advanced | Columns

v B

ﬁ [E From Text/CSV [hs Recent Sources [H Queries & Connections A~ “ v ‘ m
m [ B
=4
=

Sort & Filter Data Tools Forecast
Open Awarded Contract Revenue
[Aicratt.__- | (Year-To-Date)

Summed Sales for Open Contracts

c5
B-1 =L
$2.74mil uB.52 $90 k A-10  S57k
$63 k c17
$2.28mil - . s18k MISC
c130  (Plank) geey 2k
WKC-135 $224 k
C-130 KC-135 =i
$1.35mil $297 k
(blank)
$0.98mil
E-3
$0.50mil e B-52 . C5
$0.34mil 5884 k $4,618 k
1 S Smi
$0.04mil §0.03mi S0-12mil  S0.15mil A-10
: > = = = 2 ; 737
Qtr2 Qtr3 Qtrd Qtrl Qtr2 Qu3 Qtrd Qtr2 Qtr3 Qtrd
2022 2023

A finalized report with some nice formatting and setting up of executive level dashboards.
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File Home Insert Draw ) Formulas Data Review View Developer Help Acrobat Power Pivot

(B From Text/cs [® Recent Sources [f; [ Queries & Cor P A a &
'Y | =
c-
r_,
£

AutoSave (@ of)

[}3 From Web [“ Existing Connections
Get Refresh Stocks ] z| Sort  Filter axt to

2t Outline
Data v From Table/Range All v

Columns Sheet £

& Transform Data Que Connections Sort & Filter Data Tools Forecast

Summed Sales for Open Contracts Open Awarded Contract Revenue
(Year-To-Date)

; A-10
$2.81mil " BS2 (blank) HA7 B-1 ¢gqy r
$2.52mil $206 k 2160k C17 o90 o
. . ) $99 k 737 ¢
$57k ¢ MISC
mKC-135 C-130 8 $2k
$1.85mil £3 E-3 $249 k ¥
$308 k — k
= C-130 3
(blank) ~ KC-135
$1.00mil $486 k
CH-47 5
$0.59mil $0.58mil c17 $4,943 k
$0.40mil :
. $0.15m B-1
$0.04mil $0.05mil
- - A-10
Q2 Qu3 Qurd Qerl Qur2 Qu3 Qtrd Qur2 Qu3 elig} 737
2021 2022 2023 F-15

Qe ¥ sl oos Y

Dashboards can be refreshed manually with a click, or set to refresh when Excel is loaded.
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The below video shows June data being updated
and refreshed with data from July.
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AutoSave (@ o) [ ® 3 Cetec We 2 Search Joshuia Foraker

File Home Insert Draw Page Layout Formulas Data Review View Developer Help Acrobat Power Pivot Share ! Comments

d]
B From ¥ / [\ Recent Sources H Queries & Connections A ) [Z]2 ~ 4SZ Clear :_ﬁ 8f
BH ™ e - &3 DJ A >
& From Web 5 Existing Conne: 3 roperties . ; -4 Reapply M
Get 2 C - E 7 Geoarmoly Filter & Respy Textto _ What-if Forecast | Outline
Data ~ E5 From /Range Al ) \ 8 Adanced | Columns €6

5
Analysis v Sheet 2

Get & Tranutoem Das. Quevies & Connections Duta Types Son & Finer Oata Took Feeecast ~

A D E F G H | J K L -
FALSE 6/28/2021  1/7/2022 10/13/2021 1 $7,21200 $7,212.00 £-3 Assembly 22.92
FALSE 6/24/2021  1/7/2022 10/13/2021 1 $721200 $7,212.00 €3 Assembly 2292
FALSE 6/24/2021  1/7/2022 10/13/2021 1 $7.21200 $7,212.00 €3 Assembly 2292
FALSE 6/24/2021  1/7/2022 10/20/2021 1 $721200 $7.212.00 E3 Assembly 2292
FALSE 6/24/2021  1/7/2022 10/20/2021 1 $7,212.00 $7,212.00 €3 Assembly 2292
FALSE 6/24/2021  1/7/2022 10/20/2021 1 $721200 $7.212.00 €3 Assembly 2292

1
4
3
1
1

FALSE 6/24/2021  1/7/2022 10/20/2021 $7,21200  $7,212.00 €3 Assembly 2292
FALSE 6/28/2021 11/14/2022 8/26/2021 $5,838.12 523,352.48 8.52 Assembly 2292
FALSE 6/30/2021  1/25/2022 12/24/2021 $37,500.00 $112,500.00 C-5 Assembly 2292 0

FALSE 6/30/2021 12/28/2021 11/28/2021 $1,50000  $1,500.00 0 0 fixed_bid
FALSE 6/30/2021 9/28/2021 8/27/2021 $0.00 50.00 0 0 fixed_bid

oo ocooo o

Sales Reports Cetec Raw Data
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Use data field control buttons to glean trends

from the reports.

The following two screen captures show how
easy it is to drill down.
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Open Awarded Contract Revenue
wrcratt.. | (Year-To-Date)

MISC
=737 $2k _

E-3 ‘
=t $308k _

KC-135 | (blank) 737  A-10
mB-1 F- :
CH-47 15 <agek | $206k ss7k _sgax Bl
- S8k /Y7 $90k
m B-52 $160k i

= C-130

Cc-17
C-5
CH-47
E-3 C-130

C5 $249k

F-15 $4,943k

C-17

KC-135
S S99k

m MISC
= (blank)
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Summed Sales for Open Contracts
$5.37mil
$3.85mil
2021 2022
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